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	Developing and Customizing 
a Presentation


Overview

This chapter explains how storyboarding can promote creative thought and how PowerPoint’s outline feature can help to develop and organize slide content in an efficient way. Other concepts are color use and customizing design templates for specific topics and a unique theme. 
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Pre Test/ Post Test—Chapter 6
Fill in the Blanks

1. Three elements necessary for successful presentations include: _________, __________, and __________.
2. __________ promotes creativity, aids in brainstorming, and designing layout.
3. When using PowerPoint’s Outline feature to develop content, focus first on  _________ _________ before developing more detailed content.
4. A color scheme consisting of varying shades of blue throughout a presentation is called a _________ color scheme.
5. To create your own color scheme, choose the ________  ________ _______ hyperlink to open the appropriate dialog box.
6. The ________ option in the Recolor Picture dialog box allows you to change any color in the picture.
7. To separate the parts of an image, choose Draw, ___________. 

8. ___________ are the white circles that appear on the parts of an image when it has been separated.
9. PowerPoint refers to the Slide Master and the Title Master together as a(n) __________ __________ __________.
10. If you have made revisions to a PowerPoint design template and you want to apply the changes to future presentation, choose _________ _________ in the save as type box.
Multiple Choice
11. Which is not one of the essential criteria for developing a presentation?

A. objectives

B. schedule

C. research

D. text
12. Which print feature is most suitable for storyboarding a presentation?
A. Notes pages of blank slides
B. Handout pages of blank slides
C. Slides printed on separate pages

D. Outline pages showing bulleted lists
13. Which color is a secondary color that is created when two primary colors mix?

A. blue

B. green

C. orange

D. red
E. both B and C

14. Which is not a tip for selecting colors?

A. Avoid using conflicting colors

B. Always maintain text legibility using high contrast between text and background colors

C. Use as many colors as possible
D. Recognize cultural differences in the meanings of colors
15. How many colors are in a PowerPoint color scheme? 

A. 8 

B. 16 
C. 32 

D. 64 

E. 128 
16. Which of the following is a tip for applying color to code and signal information?

A. differentiate between items such as slide title and body text

B. emphasize text by using a different accent color

C. reflect grouping by displaying similar items in the same colors

D. all of the above are correct

17. To recolor most clip art click which button on the picture toolbar?

A. [image: image1.png]



B. [image: image2.png]



C. [image: image3.png]



D. [image: image4.png]



18. An element of the presentation’s design template that controls the formatting of the text placeholders, colors, and other elements for all slides in a presentation except the title slide is called a

A. Title master slide
B. Slide master

C. Slide-title master pair

D. Master pair
 

19. Which is not a benefit of using an original design for your presentation template?

A. design is creatively tailored to your topic

B. ensures consistency in color use and font treatments

C. increases efficiency

D. all of the above are benefits
20. Which of the following commands will enable you to change the current background color? 

A. Format, Slide Layout 

B. Tools, Change Background 

C. Format, Background 

D. Format, Slide Design

True / False
21. ___Plan content for 110% of the time you have available in case you talk too fast.

22. ___Print handouts with three blank slides on a page to create a storyboard page.
23. ___Today’s computer can create more colors than the human eye can see.
24. ___Two primary colors mix together to form tertiary colors.
25. ___The color of light blue used in a presentation conveys a meaning of friendly, sociable, and organic.
26. ___The colors that appear on the first row of the Fill Color pop-up menu are used in the current presentation’s color scheme.
27. ___Most clip art can be recolored using the Recolor Picture dialog box.
28. ___When designing your own template, you should choose background colors and graphics first.
29. ___Textures can be applied to shapes that are placed on a Slide Master but not to the background.
30. ___When formatting bullet list text, you can select different bullets from the Symbol dialog box.
Teaching Tips and Lecture Notes
Effective use of PowerPoint is an important part of presenting, but software use alone does not guarantee a successful presentation.  A computer and software are tools to help you prepare and deliver your presentation. The most important part of presenting is the presenter and the message he or she has to convey. PowerPoint can help, however, with all three elements (content, design, and delivery) that are essential for a successful presentation.  
The methods explained in this chapter could be reinforced through group discussion and practiced through development of presentations in teams of two to four students. Team development allows students to learn from each other and to share their ideas in a constructive way. 

Section 6.1 Developing and Organizing Content
Every presentation development project should address the planning criteria described in this lesson. In addition to the textbook descriptions, be sure to remind students that planning for each of these criteria should include:
· Objectives or Goals—be sure to ask “What does my audience want from this presentation?” and “What do I need to accomplish?” and then write a one-sentence objective. 
· Audience Analysis—understanding your audience is crucial so you can tailor your presentation to their needs. Be sure you address items that interest them in a way that will be easy for them to follow. Plan for ways to engage the audience and get them involved as much as possible during your presentation.
· Schedule—the available time you have influences your approach to a presentation. If time is limited, then prioritize what is most important for you to accomplish in your discussion and in your approach to designing your slide show. During delivery, be sure to stay within time limits. Decide in advance if all material must be covered. Audience questions may lengthen the time you originally estimate, so be sure you have a plan in mind for the number of minutes you expect to spend on each different segment of your presentation. If no clock is in your presentation room, you can place a small clock near your podium where only you can see it (more delivery tips are covered in the next chapter).
· Research—advance preparation is important for efficiency. Gather your information first, and then develop. If you try to collect information as you go, the entire development time will be significantly lengthened. This stage of development is important, too, for learning the content and your increased knowledge level will help you to be more confident.
· Organize—think about your purpose and the three or four most important concepts you want your audience to remember, then develop your content based on these concepts. A presentation must be delivered in a logical, well-organized sequence. But different methods of content development can help you achieve these results. It is important to develop organization skills for managing all the supporting papers and computer files that one uses during the preparation stage of presenting, too.
Presenters need to plan their message carefully for the intended audience, and every decision during the development process should be guided by these criteria. 
Presenters need to practice with both outlining and storyboarding to understand the strengths of each method and to determine which method seems to work best in different situations. Remember, the strength of outline is for organization—outlining early in the develop process can restrict the free flow of ideas because you see your thoughts developing in a linear pattern. Storyboarding’s strength is for creative thinking—thoughts about how to illustrate are considered separately as they occur to you and sketches provide a “visual map” of your presentation. Once the individual ideas are developed, however, they must be arranged in an organized, logical way.
Be sure to review with students the various sequencing plans presented in the text and ask them to decide which plan they would choose for various situations you describe to them.

Both the presentation introduction and conclusion should be thoroughly prepared and rehearsed. The introduction sets the tone of the presentation and the conclusion wraps it up. Be sure that students do not end with comments like “That’s all I have.” or “I guess that’s it.” They should provide a summary to help the audience remember, or end with a strong concluding statement.

Section 6.1.1 Outlining Topics Then Details  

Concept: 
Identify major topics first
Method:
Use this text-based method of organizing thoughts by first writing slide titles to focus on identifying presentation topics, then rearranging them into a logical sequence.
Notes:
At this stage of development, you are focusing on more general concepts, not detail.
Concept: 
Develop topic details
Method:
Once presentation topics are identified, identify the specific concepts that should be discussed for each topic. Develop bulleted lists of these items in the early stages of development. Once all content you are covering has been captured in word form, then turn your attention to how you will illustrate the concepts with images, charts, diagrams, etc. 
Notes: 
At this stage of development, you are focusing on detail.
Section 6.1.2 Preparing Storyboard Pages

Concept: 
Using PowerPoint handouts to create pages for sketching slides and adding explanatory text
Method:
Create three blank slides and print them as handouts with three on a page. This will produce three blank rectangles on the left for sketching with lines beside each one for adding notes. Copy enough pages to plan all the slides in your presentation.
Notes:
This technique provides an effective way to sketch and make notes at the same time. Sketching can help you to think more creatively before you turn to the computer to begin creating what your mind has envisioned. Then the lines on the right can be used to list the specific sound clips to insert or files to which you plan to hyperlink so you are better organized when you start creating the slides.
Section 6.1.3 Planning the Opening and Closing by Storyboarding

Concept: 
Use the storyboard technique to sketch the opening and closing slides of a presentation. Think before using the computer. Think creatively.
Method:
Use the storyboard page created in the previous lesson to plan the two slides. Be sure the title slide has a more dramatic appearance then the slides that make up the body of the presentation. Be sure the closing slide has a summary statement.
Notes:
For a future presentation, require that students storyboard a presentation to help them master this concept. Explain the purpose of storyboarding to foster creative thinking, because this method of sketching before developing will not be obvious to them and they need to understand the value of preplanning to speed up their development time when they are using the computer. In addition to using printed pages, students could storyboard on note cards or Post It notes arranged on the inside of a file folder. 

Section 6.2 Working with Color

When students begin working with color, encourage them to try different combinations to help them develop a sense of design. This is usually fun for them and they will enjoy the challenge of creating their own combinations. However, color is an important communication tool and should not be used randomly. So students need to learn that color can convey meaning and affects the tone of a presentation. 

To learn more about color theory, much information is available on the Internet.  Here are two especially useful sites:
· www.colormatters.com   This site contains information about the psychology of color, how color affects actions/reactions, color theory, plus much more and many links to additional resources. 
· www.color-wheel-pro.com   This site contains information about color theory, classic color schemes, color meaning, and a glossary of terms.  Color Wheel Pro is a program designed to help you create harmonious color schemes. You can download it for $39.95 (educational prices are available). 

Be sure students have an appreciation for the symbolic meanings of color.  They need to understand the difference between CMYK color systems and RGB color systems to understand why slides developed may look different on their monitor compared to when they print. PowerPoint’s Colors dialog box is a good tool to use to explain the hues of the color and the impact of increasing/decreasing saturation and luminance. Review with students the principles of color selection.
Section 6.2.1 Customizing Color Schemes for a Unique Theme

Concept:
Creating a unique color scheme using the Edit Color Schemes dialog box
Method:
Apply a design template for your current presentation. Then from the Slide Design task pane, click the Color Schemes link near the top of the Slide Design task pane. Then click the Edit Color Schemes link at the bottom of the Slide Design task. 
From the Edit Color Scheme dialog box, select each of the eight colors that make up a PowerPoint color scheme and click the Change Color button to change them one-by-one. The affect of the color will immediately appear on the thumbnail image that shows where the color is typically applied. When you are satisfied with the results, click the Apply button.
Notes:
Be careful when you make color selections so you maintain good color contrast between text colors and the background colors so text is easy to read. Changing slide colors this way is much more efficient than manually making the changes on each slide. 
 Section 6.2.2 Coding for Different Meanings

Concept: 
Applying color to help communicate meaning
Method:
The way color is applied can help an audience distinguish between slide titles and body text, differentiate between items such as parts of a chart. Color can help an audience recognize special annotations or instructions by the way you emphasize text with an accent color or combine colored shapes for particular meaning. Color can reflect groupings by making like items the same color and association by coloring items for a particular meaning.
Notes:
The most bold or dramatic treatment will always be considered the dominant treatment.
 Section 6.2.3 Re-coloring Clip Art Images

Concept: 
Using the Recolor Picture dialog box is an efficient way to recolor many of PowerPoint’s clip art images. 
Method:
When a picture is selected, this feature is available through the Picture toolbar or by using the right-click menu.  So from the Recolor Picture dialog box, select each original color and replace it with a new color. You can change colors (fills and lines) or fills (background or fills, no lines) and the result of your change will be displayed as you make it in the image on the dialog box. You can also preview the image to see how it looks on the slide before actually accepting the change.
Notes:
This method is a quick way to adjust your colors to better match your color scheme and make your overall design appear more professional. However, only solid colors can be applied, not gradient colors, textures, or patterns.
Section 6.3 Customizing Design Templates

In addition to changing a design template’s color scheme, the background graphics, placeholder positioning, and alignment can be changed for an original design. Or you might want to remove some or all of the existing graphics to add your own designs.  This capability of PowerPoint enables a presenter to design a background for a specific topic.

Students need to understand the benefits of an original template to provide a fresh, topical approach to overall design. The guidelines in the text suggest choices for fonts that will assure readability. When redesigning the Title Master and the Slide Master of a design template, be sure they are designed to work well together for presentation continuity and a unified theme. Many professionally-designed templates are available for purchase and from Web sites at a low cost or even no cost.
Section 6.3.1 Changing Slide Backgrounds

Concept:
Changing the background color of one slide or all slides
Method:
To change the background color of the current slide, choose the Background menu item from the Format menu.  In the Background dialog window that appears, click the drop-down arrow to select a new background color.  Then, click the Apply button to apply the new background color to the current slide.  If you wish to apply this color to all slides, then click the Apply to All.

Notes:
None.

Concept:
Applying an alternate fill effect to the background gradient, pattern, or texture
Method:
Rather than using a single color fill on the background, you can select one of four alternate backgrounds.  These include gradients, textures, patterns, and pictures.  To access these options, use the Background dialog window as described above and click on the drop-down arrow to access the Fill Effects… menu item.  

Next, click on the appropriate tab at the top of the Fill Effects window that appears and use the controls for that section to design an alternative background for your slides.  When you are satisfied with the design, click the OK button to return to the Background dialog window to complete the application of the background to the slides.

Notes:
Be careful when using gradient, pattern, or texture effects to make sure your text is still readable. Solid color areas often work better behind text because it makes text easier to read. It can be difficult to use a picture as a background fill because the picture may overpower the text you need to display.  A semitransparent rectangle over the picture in the area where text is displayed can make the text easier to read.
Section 6.3.2 Editing a Slide Master from an Existing Template

Concept:
Editing the Slide Master

Method:
To apply formatting changes (font style, font size, color scheme, graphics) to all of the slides in a presentation except the title slide, edit the Slide Master.  Choose the Master menu item from the View menu, and then choose the Slide Master menu item.  If it is not already selected, click the Slide Master thumbnail images in the left pane to edit.

You can remove unneeded graphics and modify the Slide Master to add your own. When you have completed changes to the Slide Master, click the Close Master View button on the Slide Master toolbar to complete the formatting changes.

Notes:
You can quickly move between the Slide Master and the Title Master by clicking on their respective thumbnails or clicking on the top and bottom of the scrollbar. These two masters are considered a Slide-Title Master Pair.
Section 6.3.3 Editing a Title Master from an Existing Template

Concept:
Editing the Title Master

Method:
Formatting changes (font style, font size, color scheme, graphics) made on the Title Master will affect the title slide layout only.  Choose the Master menu item from the View menu and then choose the Title Master menu item.  Use the same techniques to modify this master and to move between the two masters. 
Click the Close Master View button on the Slide Master toolbar to complete the formatting changes. Now these changes will be applied to any slide you create with the title slide layout. Remember that the title slide should always have larger text and a more distinctive appearance than the other slides that make up the body of the presentation.

Notes:
It is possible to use more than one Master Pair in a presentation, but one must be very careful when doing this so that one doesn’t violate the need for continuity in the presentation.
Section 6.3.4 Creating a New Template from a Blank Slide and Title Masters
Concept: 
Starting with a blank slide and creating a unique design template using the Slide-Title Master Pair
Method:
Start a new blank presentation then access the Slide Master as described in 6.3.4 and make color scheme and all other adjustments you need. To add a Title Master, click the Insert New Title Master button on the Master toolbar. 
Notes:
When revising an existing design template, you will always have a Slide Master and a Title Master. When you start with a blank presentation, you start with the Slide Master only and you must add the Title Master. 
Pre Test/Post Test Answers

	
	Fill in the Blanks
	Multiple Choice
	True/False

	
	1. content, design, delivery (6.1:PP 250)

2. Storyboarding (6.1:PP 250)

3. slide titles (6.1:PP 251)

4. monochromatic (6.2:PP 258)

5. Edit Color Schemes (6.2.1:PP 262)

6. Colors (6.2.3:PP 269)

7. Ungroup (6.2.3:PP 269)

8. Handles (6.3.2:PP 270)

9. Slide-Title Master Pair (6.3.3:PP 274)

10. Design Template (6.3.3:PP 287)


	11. D (6.1:PP 250)

12. B (6.1.2:PP 255)

13. E (6.2:PP 258)

14. C (6.2:PP 261)

15. A (6.2.1:PP 263)

16. D (6.2.2:PP 267)

17. C (6.2.3:PP 267)

18. B (6.3:PP 274)

19. D (6.3:PP 274)

20. C(6.3.1:PP 275)


	21. F (6.2:PP 251)
22. T (6.1.2:PP 255)
23. T (6.2:PP 258)
24. F (6.2:PP 258)
25. F (6.2:PP 259)
26. T (6.2.1:PP 264)

27. T (6.2.3:PP 267)
28. T (6.3:PP 274)
29. F (6.3.1:PP 277)
30. T (6.3.2:PP 285)



Self Check Question Answers
1. The three primary colors shown in the “color wheel” are red, yellow, and blue. From these colors all other colors are created.

2. RGB color is the color system used by computers—red, green, and blue. From these colors all other colors are created.

3. The computer terms regarding color are defined as:

· Hue—the actual color (also called purity)

· Saturation—the intensity of the color

· Luminance—the brilliance or brightness of the color (amount of white or black, also called luminance)

4. Color can be used to code and signal information by using varied colors to differentiate between slide elements such as title text and body text, draw attention to objects, reflect groupings of like items, or show association such as negative numbers in red.

5. It is important to avoid random changes in colors within a presentation because color should be applied for a reason and to achieve the greatest communication impact.

6. Many symbolic meanings are associated with various colors. Three examples include

· dark blue—stable, calming, trustworthy, mature

· red—danger, stop, negative, excitement, hot

· yellow—sunny, cheerful, optimism, caution

7. One benefit for designing a new template or modifying an existing template for a presentation is that you can create a creative design tailored to your topic and it is a unique design. No one has seen it before.

8. To insert a picture as a slide background, 
CHOOSE: Format ( Background
In the Background fill area
CHOOSE: Fill Effects
CLICK: Picture tab
CLICK: Select Picture command button
Navigate to where your picture is stored
DOUBLE-CLICK: to open the picture
CLICK: OK
9. The Slide Master controls the formatting of all the title and text placeholders in a presentation as well as colors and other elements such as shapes and images.

10. The Slide Master controls the appearance of all slides for the body of the presentation; the Title Master controls the appearance of only the Title slide.

	True/False 
	Multiple Choice

	1. T

2. F

3. F

4. F

5. T

6. F

7. F

8. T

9. F

10. T
	1. B

2. D

3. A

4. B

5. B

6. D

7. D

8. A

9. C

10. C



Additional Exercises

Activity 1

Read several of the articles about color at these Web sites:         
· www.colormatters.com   

· www.color-wheel-pro.com    

Develop an original design template with appropriate graphics and color scheme for a presentation about color.
Activity 2

Using the information obtained in Activity 1, develop a presentation about color. Print storyboard pages and sketch the slide content. Include one or two illustrations from the sites that you save and cite the URL where the images were obtained on the slide where the image is displayed.
Activity 3

Select one of PowerPoint’s design templates and customize its color scheme and background graphics for a presentation about a new benefits program being introduced where you work that you know employees will like. Because they will consider this good news and react positively to the announcement, you can use bright, cheerful colors. 

Then consider how you would modify the color scheme for this presentation if the benefits program being introduced has a reduction in services. Employees will consider this bad news and they will react negatively. Make a second version of your design template with softer colors.
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